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Glossary: 
 
Ref : Something that somebody wrote or made to teach you 
 something 
 
Parent : A ref that contains multiple refs by different people 
 [ usage: The parent of a chapter is a book ] 
 
Load : To retrieve information into the program memory, 
 changing the display. 
 
Situate : Move files to their proper location, the Library 

Things to Know: 
 
• The database is fully relational. In other words, each author is 

represented only once and is ‘linked’ to the things they’ve 
written. Similarly, articles are ‘linked’ to journals, and chapters 
are ‘linked’ to their books.  

 
• The entire application has automatic saving. Every time you 

leave a field, that field is saved. For multi-line fields, saving 
only occurs if changes are made.  

 
• Each source must have a unique combination of Title, Year, and 

Type (i.e., article, chapter, etc). Thus, any new insertion that 
has the same three as an old ref will be treated as a duplicate. 
If it has information that the old one doesn’t, the ref will be 
updated, but it will not overwrite any fields.  

  



Features 
 

Fully Relational 
• Articles/Chapters are linked to their "parent" Journal or Book . . . 
• Authors are linked to articles . . . 
• Each is fully editable, which then updates all associated refs 
 
Advanced APA Reference Handling    
• Imports RIS, ISI, and OVID reference files.  
• Parses most refs in APA citation format 
• Also parses journal article and book refs in MLA, Turabian, and some 
Chicago styles 
 
Easy File/Location Keeping 
• Drag and Drop Files to associate and name them 
• Delayed File Moves. Manage files while they are open. 
• Easily open any kind of file, a url, or just write a note 
 
Multiple Find Options 
• Categorize references in multi-level topic structure 
• Full text searching for references and authors. With highlighting. 
• Two clicks to display by author, type, or source 
 
Notes 
• Keep both an abstract and notes for each reference 
• Keep notes about authors 
• Separate field for storing author's websites. 
 
And More . . . 



Main Screen/Tab 
 

Useful for browsing through references.  
Toggle what 

is Visible 

EZSearch for: 
Topics 

Authors 
Full Text 

See the current 
display criteria and 

access previous 
displays 

Full Ref 

Topics 

Notes 

Abstract 

Tabs 

List of all refs 
meeting a 

certain criteria 

Menu Bar 



Main Tab Ref Display 
 

The Control Center.  

These are ‘full’ locations. 
 

Locations that are recognized 
file types will display the 
appropriate icon, or show the 
file extension.  
 
If the location is not 
recognized as a file or 
internet address, the field 
will be treated as a note, 
displaying a paper icon and 
popping up a dialog box with 
the text when clicked. 

These are ‘empty’ locations. 
 

Drag a file here to associate it 
with the Ref (and move it to 
the Library if enabled). Or, 
click to open a dialog box for 
manual entry of a filename, 
url or note. 
 
Journal Articles will display 
the ’CrossRef’ label, meaning 
that clicking will open your 
internet browser to the 
CrossRef location to search for 
it. [Can change in refman.ini]  
 
Modification of the location is 
only possible on the Edit Tab. 

This Ref 
has a 

linked PDF 
file. Click 
to open it. 

The Parent of this Ref 
(i.e., a Journal or Book) 

has a linked URL.  
Click to open your default 

browser and go there. 

Load the previously displayed 
Ref. It will return to a previous 
search/list display as necessary. 

Navigate up and down in the reference 
list. Useful for when the list is toggled 
‘off’ (i.e., you can’t see it). Often, you 
can you the up and down keys on your 

keyboard. 



The Menus 
 

Always there when you need them. 

File: 
 Datababse: Go here to change or create new databases 
 Backup DB: Perform a quick backup of the data 
 Refresh Search: To refresh the full text index when using 

 Sqlite, to fix any problems with it not finding refs.  
 
Refs: 
 Format Selection (i.e., APA / MLA ): Change the display of the 

 full ref. Does not affect parsing of refs, just display.  
 Bibliography: Save a file with a fully formatted Reference page. 
 Export: Choose a format to transfer refs to another program. 
 Export Scope: Currently, only records currently displayed in the 

 list will be included in the Bibliography and Export files.  
 
View: 
 Recently Modified: The default view. What is ‘Recent’ can be 

 specified in Preferences.  
 Special: Some special searches that might be useful. Note that 

 Refs with no linked authors are not otherwise displayed.  
 Search Scope (Within Current / Search All): Change to ‘Within 

 Current’ to combine searches.  
 Format Types: Select these to display all Refs of a single type. 

 Note that Journals are not otherwise displayed.  
 
Help: 
 About: See the program version 
 Manual: Open this manual file 



The Menu lets you Delete or 
Replace the Reference  

Edit Tab 
 

When you need to make changes to a reference. 

Use the buttons to add, change, 
or delete authors if needed.   

Double-clicking an author loads 
them and goes to the Author Tab 

Right Click to Format it nicely, or 
to search the web for more info. 

You can change the type of 
reference if needed. 

Click on the Parent to load it.  
If there is no parent, click in  

this area to choose one.  
Click the X to remove the Parent. 

These fields change depending 
on the type of reference. Pay 

attention to the labels.  

The abstract is repeated here for 
ease of entry. You can edit it 

either place.  

If you click here, you’ll be able 
to edit the location. You can 

also drag a file to this place to 
set it as the location.  

To produce this view, the 
List has been toggled ‘off’ 



Authors Tab 
 

Useful for browsing through references.  

Click the Label to open the 
website in your browser.  

When you click on an author, it 
will search for refs by them. 

A list of all the people who share Refs 
with the selected author, ordered by 
how many Refs they share. Double-
click on a name to load that person.  

Write notes or comments about 
an author. 

Start typing an Authors’ last 
name to find them alphabetically.  

A list of all authors in descending 
order by how many refs they have.  
Click on a name to load that person 

The # is the “rank” of the 
author on that article (i.e., a 
1 means that person is the 

1st author) 



A list of authors who match will 
appear here. To bring back the 
normal list, use the ’Authors’ 

menu at the top of the tab and 
choose ’Refresh List 

You can type any keywords 
here to search through the 
Area, University, and Notes 

fields.  

Author Tab - Full Text Search 
 

Useful for finding people who do particular things.   

Words that match 
your search term will 

be highlighted. 



Insert Tab 
 

When you have more to keep track of (or read).  

Double-click in the box to open a dialog box 
for you to enter the authors or editors. If 
you select an author and press the delete 

key on your keyboard, it will remove them.  

You can use these Location, 
Abstract, and Notes fields normally 
to reduce the need to go back and 

edit references you’ve inserted.  

As on the Edit tab, these fields differ 
depending on the type of reference. 

Typing in the source will generate matches 
from the database that you can select. 

Tabbing out of the field will fill in the Type 
and Year fields, unless they are already filled. 

See the next page for 
information about this box. 

Red text indicates that a reference 
with a matching title already exists in 
the database.  The red text itself is 

from the existing record.  

When the Insert Tab is displayed, clicking 
the ‘+’ button next to the ezsearch will 
place that topic here, associating it with 
any refs subsequently entered. To clear 
this box, right-click and select delete.  

Manual Insert: Type in the 
appropriate information in 
each box, and click Insert.  



Inserting Refs 
 

Even better than typing them in.  

Getting Files for Importing: When exporting refs from other programs, 
choose ‘Direct Export’ or ’Export to Reference Software’ , otherwise pick 
that which mentions Reference Manager or RIS files, otherwise EndNote. 
This works for PsychInfo, WebofScience, ScienceDirect, EBESCO, etc. 

Parse: Split the 
first ref in the box 

above into the 
boxes below. 

Pretty flexible, try 
it out to see what 

is works. 

Insert: Insert one 
ref into the 

database using the 
boxes below. If no 
info in the boxes, 

will perform a 
Parse first.   

Next: Delete the 
first ref in the box 
above and parse 
the next one. Use 
when you don’t 
want to insert 
something.  

To Import a Ref 
file, you can 

simply drag the 
file into the box. 

The same as 
doing ‘Insert File’ 

Menu Options: 
Direct Insert: Parse and Insert all the Refs in the 
Box at once. Should use only if the Refs are in 
standard format.  
Insert Files: Imports Refs from ALL the files in the 
‘Import’ Directory 
Insert File…: Imports Refs from the selected file 

Pasting Refs for Parsing: It is best if they are in standard APA 
format, but there is some leeway. They must have an ending period 
and be separated by a line break, but may have line breaks within. 



Abstract Abstract Abstract 

Searching 
 

Quickly find what you want.  

You can combine searches by 
choosing to ’Search Within’ from the 
‘View’ menu or the ’Search’ menu.  
 
Note that you can only combine 
different types of searches. For 
instance, you can search for articles 
by a particular author and 
associated with a particular topic. 
But you cannot search for articles 
associated with two different topics 
or two different authors. 
 
The search mode persists until you 
switch it back.    

When you load a ref, it will 
highlight all the terms 

currently in the search box 
(regardless of whether you 

searched with them) 

If you are using the 
MySQL database, you can 

select which fields to 
search in from this 

‘Search’ menu. 

Search Symbols: 
* Wildcard character 
+ Term must be present 
-  Term must not be present 
“” Group terms 

——— 
If & or , a number is present, it will 
search for articles matching that short 
citation (i.e., Wilson & Brekke, or 
Wilson, 1994 to find Wilson & Brekke, 
1994).  



Keyboard Shortcuts 
 

For putting the ref in papers.   

Using the displayed ref as an 
example, the following are what 
gets copied to the clipboard for 
each key combo (or when choosing 
from the menu). These short cuts 
work from anywhere in the 
program. 
 
Full Ref ( Ctrl-F ): 
Wilson, T. D. & Brekke, N. (1994). Mental 
contamination and mental correction: 
Unwanted influences on judgments and 
evaluations. Psychological Bulletin, 116, 
117-142. 
[ Left click on the display also does this ] 
 
Cite Ref ( Ctrl-D ): 
(Wilson & Brekke, 1994) 
[ lists up to 6 authors ] 

 
Short Ref ( Ctrl-S ): 
(Wilson & Brekke, 1994) 
[ if 3 or more authors, does ‘et al.’ ] 

 
Author Ref ( Ctrl-A ): 
Wilson and Brekke (1994) 

 
Location ( Ctrl-L ): 
C:\Documents and Settings\User\My 
Documents\Library\Wilson & Brekke, 
2002.202.pdf 
[ useful for sending files over email ] 

Right-Click to bring 
up this menu.  

Left-Clicking on the Ref is 
the same as ’Copy Full Ref’  



The Library / Preferences 
 

One way of customizing your experience.  

The Library: If you like to keep all your articles in one 
location on your computer, you will probably want the 

program to move, or ‘situate’, a file there when it is associated 
with a reference. When moving, the file will also be renamed.  

 
Files that are in use cannot be moved, so a list is maintained 
of files not yet processed. If there are files to be moved, they 
will be starred and you should choose ’Situate Files’ from the 

File menu when they are not in use.   

Levels of Customization: 
 
Beginner : Use the Preferences dialog box only 
 
Intermediate : See the refman.ini file. Many of the   
settings there can be changed in Preferences, but not all. 
 
Advanced : See the library.conf file. Controls importing, 
exporting, and displays. Requires basic knowledge of perl, 
or ability to follow patterns.  Always back it up. 
 
Expert: Feel free to alter the code. Move the files out of 
the scripts directory and run viewer.pl. Note that you 
must obtain and install the required modules yourself.  



Add Author Box 
 

To associate authors with refs.  

This field makes it easy to enter names, as it 
matches what you type to authors already in the 

database and auto-completes for you.  
NOTE: It does not actually get submitted,  

it is for convenience only.  

These fill in automatically 
by splitting the field 

above by commas and 
spaces. Adjust them 

individually as needed.  

Click here to insert 
this author and 

return back. Used 
for just inserting 

one author, or when 
inserting the last of 
a series of authors.   

Click here to save 
the author in 

memory and add 
more. Nothing will 
be saved until Add 

One is chosen. 
  

Click here to cancel 
the entire 

operation. If you 
just want to stop, 
click ‘Add One’ to 

finish (it won’t add 
a blank author).    



Topic Area 
 

Managing your Topics is like managing your life.   

Keep notes for the 
currently activated 

topic (in blue).  

Remove: 
Delete the 
currently 
selected 

topic 

Add : Create a sub-topic 
of the topic selected (or a 

top-level topic if none 
are). Topics must have a 
child in order to display, 

so it will add a temp child. 

Click to 
retract the 
topic area 
(make it 
go away) 

Drag the 
sashes to 
resize the 
topic area 

Single-click to select a topic, 
open/close it, and put it in the 

topic box.  
Double-click to active a 

topic, loading it’s notes and 
displaying the associated refs.  

Note: To produce this view, the Notebook (NB) is toggled ‘off’ 
and the topic area has been opened. 

Click to 
open 
this 
Topic 
Area  

Right-Click in 
this box to 

rename topics, 
tidy or refresh 

the list.  



The Status Bar & EZSearch 
 

The really important things come in small spaces.   

Click here to choose  
whether the box is for 

Topics, Authors, or 
Keywords. Typing in a 

term then pressing 
‘Enter’ will do a search. 

The 
# of 
refs 

in the 
list. 

Double-
click to 

force the 
window 
to stay 
on top.  

Associate the current ref 
with the topic displayed in 
the box to the right (if a 
topic). To de-associate, 

select the topic, and press 
delete on the keyboard. 

Database 
ids for 

the 
current 
ref and 
author. 

EZSearch box: What this box does 
depends on what label it has. It is 

helpful particularly when the 
Notebook (NB) has been toggled ’off’.   



Tips and Tricks 
 

Putting the Fun back into Life.   

• When exporting Refs from online databases, have the 
files save to an easy to find location, like the desktop. 
Then, just drag the file into the box on the Insert Tab.  

 
• If you leave the Library turned on (i.e., letting it move 

files), dealing with the downloaded full text of articles is 
just as easy. Simply save them to the desktop, then 
drag them to the appropriate location spot. The program 
will give it an appropriate filename, and even treat it 
like a pdf (which most are) if there is no file extension. 

 
• The parsing box on the Insert Tab was specifically 

designed to accept pasting from the Reference sections 
of other articles. You can copy in the whole list and use 
the ‘Next’ button to skip Refs you don’t want.  

 
• If the parsing isn’t working, it may be easier to adjust 

the Ref to be more standard in order to make it work 
than to type in each part of the Ref yourself. Sometimes 
all it takes is adding a period or space, or a placeholder 
for a missing piece that you can then remove. 

 
• When inserting a Ref, if the Parent already exists, you 

don’t have to put in the details like City and Publisher. 
When you’ve typed in a source that already exists, it will 
select the appropriate type and year. Those three fields 
(title, type, year) define a unique reference, so the 
existing source will be linked.  

 


